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Templates and Styles

Learning Module Objectives

When you have completed this » Create a template
learning module you w ill h ave * Use atemplate
seen how to: « Create a style

* Useastyle

« Edit a style
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* Templates are pre-
designed and
formatted
spreadsheets

— They provide

— They save time and

What Are Templates?

General | spreadsheet Solctions | Office 97 Templates | Business Planner Templats ... |

’—Preview—l

[2]x]
General Spreadsheet Solutions |0Fﬁce 97 Templates | Business Planner Template ... |

{Expense Inveice Furchase Wilage: A
EStatemenp Order Software

consistenc y of
layout/structure

repetition of work

Select anicon ko
see a preview,

concel |

Excel 2000 Advanced - Slide No. 2

What are Templates?

Background

Frequently when working with spreadsheets you want to use the same layout or
design. You can re-create the design every time you want to use it, or you can
create a spreadsheet to use as a pattern. The spreadsheet pattern is called a
template.

Templates can be produced that include the following elements:
» Text and graphics

» Formatting information - Layouts, Styles

* = Headers-and Footers

* Formulas

e Macros

Templates are stored with the extension .XLT and when they are accessed to
create a.new.sheet, a.copy of the original.is.made... The original template is left
untouched ready for further use.

A template is-produced-by creating a spreadsheet.that contains all the elements
you want, and then saving it as an .XLT file.

SAMPLE ONLY NOT TO BE USED FOR TRAINING

O Cheltenham Computer Training 1995-2000 - Tel: +44 (0)1242 227200 - Fax: +44 (0)1242 253200

Email: sales@cctglobal.com - Internet: http://www.cctglobal.com/

Excel 2000 Advanced



Templates and Styles

3

Excel 2000 Advanced

/

N

[0 1995-2000 - Cheltenham Computer Training

Save in:

© Cheltenham Computer Training 1995-2000

Creating Templates

I [ Templates

=l
Business Planner Templates for UK and ALS
Office 97 Templates

File narne: Biookl.xds

Save as bvpe! |Microsoft Excel Workbook, (*,xls)

=—————Microsoft Excel Workbook (*,xls)
Web Page (*,htm; *, il
‘Templat i
Text (Tab delimited) (* kxt)
Unicode Text (*,txt)

= \Microsoft Excel 5.0/95 Warkhook (*.xls) bt

Excel 2000 Advanced - Slide No. J

Creating Templates

To create a
template

Create the workbook you wish to save as a template.

From the File menu, select Save As to display the Save As dialog box.
Type the name for the template in the File name text box.
From the Save as type drop down list box, select Template .

You should find that the folder automatically changes from the default of My
Documents to the Templates folder, as illustrated below.

B
I[:l Templates j 'y

- Business Planner Ternplates For UK and ALLS
Office 97 Templates

Select Save:. The-extension .XLT is added to the file name and the template is
saved inithe Templates folder.

Save in:
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Using Templates

General Spreadsheet Salutions |OFFI(E 97 Templates | Business Planner Template ... |

\

. h
From the 5] ] ®] 5]
. S S = =
Fl | e m e n u f {Expense Invvgice Purchase Village IREHED
EStatemenp Order Software

select New | —
to d |Sp | ay General | Spreadsheet Solutions | Office 97 Templates Business Planer Template ... |
the New 5] 8] &) 8] JEo

= i) = =] )
d H | b {Advertising! Balance Sheet Balance Sheet  Break Even TREEm

I a Og OX Analysis. xlti - Summary ... - Two Years...  Analysis.xlt
] =] =] #]
) ) —J )
N Eudgeted Cash Flow Cash Flow Debtors’
Profit and L... Forecast - ... Forecast-T... Schedule.xdt Select anicon to
see a preview,
= B =] 5] @]
) ) — )
Exercise - Exercise - Exercise - Exercise -
Accounts ... Adjusting ... Calulati..  Calculating ...

\\ © Cheltenham Computer Training 1995-2000

cancel_|
Excel 2000 Advanced - Slide No. 4

Using Templates

Touse a .
template .

From the File menu, select New to display the New dialog box.
Select the template you require. Notice that you normally see a number of tabs
on this dialog box, such as General and Spreadsheet Solutions

. If you wish to

use the default template, select Workbook™ from the General tab.
*/ Select OK to open.a copy of the.template, i.e. a Workbook .
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What are Styles?

» Styles are sets of information about how a
spreadsheet is formatted

Style
Style name: = OK
Skyle includes
Caniel
IV Murnber General

Madify...
¥ alignment General, Bottom Aligned ety

Iv Eont Arial 10 Add

v Border Mo Borders Delete

FlEE RS

[ Patterns Mo Shading Merge. ..

¥ Protection  Locked
© Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 5

What are Styles?

Background A collection of cell formatting information is often referred to as a style. If
formatting information is assigned to cells using styles it is possible to easily
update the appearance of a sheet by modifying the styles.

Change one style and. all cells that have that style assigned to them will reflect the
changes made.

The information held in a style includes the following formatting details:

* . Number

e Font

e Alignment
" Border

e Patterns

» Protection
You have the choice when defining styles to exclude any of the above as you wish.

Excel comes with a number of styles pre-defined, by default all cells have the
Normal style assigned to them.

It is possible to-copy styles from one Workbook to another:
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* Fro

Style dialog box
* Type the style name in the Style name drop-down list

Creating and Using Styles

m the Format menu, select Style to display the

Format Cells [ 7] %]

Tarier | afgnment | Fort | Border | Fattems | Frotection |

Category: I—Sample—
Style [2]x] ‘
Style name: =
General Format cells have no
Style includes specific number format.,
Cancel
W Mumber General
Modify...
V¥ alignment  General, Bottom Aligned ;I
¥ Eont Arial 10 Add
¥ Border Mo Borders e
¥ pattetns M Shading Merge. ..
¥ Protection  Locked

Cancel
© Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 6

Creating and

To create a style

To use a style

To edit a style

Using Styles

» Select a cell formatted with the attributes you require.

* From the Format menu, select Style to display the Style dialog box.

* Type the style name in the Style name drop down list.

/' Select the'Modify button to change any.of the attributes. The Format Cells
dialog box will be displayed. Click on the Number , Alignment , Font, Border ,
Patterns and Protection tabs and make any.changes required. Select OK to
return to the Style dialog box.

* Select OK.

» Select the range you wish to format.

* From the Format menu, select Style to/display the Style dialog box.
» Select the style from the Style name drop down list box.

* Select OK.

« From the.Format _menu, select Style to display the Style dialog box.

» | Select the style you want to change from the Style name drop down list box.

» Click the Modify button. Make the changes required by clicking on the various
tabs, and choose OK to return to the Style dialog box.

* Select:OK:All the cells which are formatted with this-style will be updated to
reflect the changes.
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Review Questions
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Review Questions - How Would You ...

Create a template?

Use a template?

Create a style?

Use a style?

ISR L

Edit a style?
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Importing Data

Learning Module Objectives

When you have completed this * Import text into a sheet using the Text Wizard
learning module you w ill h ave « Import data from a Database
seen how to: * Use Microsoft Query to interrogate an external database

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Why Import Data?

Excels ability to analyze information is useful

Information you wish to analyze may have a different
original format: s
— Word processor - Word, Word Pro

— Database - Access, dBase, Paradox
— Spreadsheet - Lotus 123, Multiplan

— Other file formats

Excel 2000 Advanced - Slide No. J

Why Import Data?

Background

The following
Text Formats
are the most
common:

Text

Text
(Tab Delimited)

Formatted Text

CSV (Comma
Separated
Values)

Excel as we have already seen is capable of carrying out analysis of data, and
producing graphical representations of the same.

If the information;you-have is iniaWord/Text-Processor in the form of a report it would
need to be in a format that Excel can recognize in order to be imported.into the
spreadsheet, rather than re-entered (typed).

What happens if the text to be imported is not in a recognized format?

If the text to be imported is not in a recognized format Excel will automatically launch
the Text Wizard to give you assistance.

Text files are plain text with no formatting information contained except line returns. It
is usual for this file type to have one record of information per line but the means of
identifying fields varies.

In this text file format tabs are used to define fields.
Formatted.text-files make use of.position:to define fields;.each field starts at a defined
position on the line.

You may find this field type also referred to as Space Delimited, Fixed Width, and

Column Delimited .

Commas are used by CSV text files to delimit (separate) fields. Whilst these are called
Comma Separated Values text files, commas do not have to be the delimiter.

Comma delimited fields can make use of the vertical bar (| ) and the at ( @ ) sign as
the delimiter.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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The Text Wizard

In the Open dialog box, select Text Files in the Files of type
field

Text Import Wizard - Step 1 of 3 EHE

The Text Wizard has determined that your data is Delimited.
If this is correct, choose Mext, or choose the data type that best describes your data,
riginal data type

Choose the file bype that best describes yvour data:

i+ - Characters such as commas or tabs separate each Field.
" Fixed width - Fields are aligned in calumns with spaces between each field.

Skart impart at pow: I 1 5‘ File: origin: IWindows {ANST) - l

Preview of file D:\backup of robs seerveridataldata\DAT.. . \busbrek.bxt,

"Mr. ", "D. Holmes",K "Jacobean House", "Queen Scguare" "Winchcowmb ﬂ
"M=_ ", "Haren Baucke",6 "Larks Nest", 6 "Browmhill Farm","N. Woodc

"Mr=.","Diana Beawer","The Malt House","Poulton","Cirenceste
"Mr_","Philip Eeawer","The Malt House" "
LM ", "T. Brigston","Church Farmhouse",

oulton", "Cirenceste
JLlittledean", "Glos| 4 I

| -
Cancel | < Back | Mext = I Einish |

& [ Je Jeo oo =

© Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 10

The Text Wizard

Background The Text Wizard is a set of dialog boxes that guide you, the user, through the
stages of importing text into an Excel spreadsheet.

To import text * /. Open the File'menu and select the Open-option.

int_o a sheet » Click on the down arrow next to-the Files of type ' field and select Text Files .

using éhe Text * Highlight and choose the file you wish to open and select Open.

Wizar

You will see the Text Import Wizard (Step 1 of 3) dialog box, as illustrated.

Text Import Wizard - Step 1 of 3 HE

The Text Wizard has determined that vour data is Delimited.
If this is carrect, choose Mext, or choose the data bvpe that best describes vour data.
riginal data type

Choose the File bype that best describes wour data:

(o - Characters such as commas or tabs separate each field,
¢ Fixed width - Fields are aligned in columns with spaces betwesn each field,

Skart impork ak pow: I 1 5‘ File arigin: IWindows [AMST) hd l

Preview of file D:backup of robs seerveridataldatatDAT. . \busbrek. bxt.

"t "Me. ", "D, Holmes","Jaccbean House","Queen Scuare", "Winchcooub =
", "Ms_ ", "Earen Baucke","Larks Nest","Brownhill Farm" , "N. Woodc
", "Mr=_ ", "Diana Beawver","The Malt House", "Poulton","Cirenceste
My ", "Philip Beawer","The Malt House","Poulton", "Cirenceste
"Mr._","J. Brigston","Church Farmhouse" "", "Littledean",K "Glos

| A
Cancel | < Back | Mext = I Einish I

a [Jon [ Jer o =

SAMPLE ONLY NOT TO BE USED FOR TRAINING

O Cheltenham Computer Training 1995-2000 - Tel: +44 (0)1242 227200 - Fax: +44 (0)1242 253200
Email: sales@cctglobal.com - Internet: http://www.cctglobal.com/




12 Importing Data

[0 1995-2000 - Cheltenham Computer Training Excel 2000 Advanced

Notice that the dialog box has two effective areas, the upper referring to choices
you can make, the lower showing the data you are about to import. The wizard
takes an educated look at your source data and the original file format and
determines whether it is delimited or not. You can choose to alter this decision if
you wish.

» Having made your choices click Next and the Text Import Wizard
(Step 2 of 3) dialog box is displayed. The upper half of this box allows you to
select the required field delimiter. The default is Tab.

Text Import Wizard - Step 2 of 3 HE

This screen lets you set the delimiters your data contains, You can see
haw your ket is affected in the preview below.

lirniter
Il [~ semicalon v Comma

[ space [ oOther: I_ Text gualifier: I jv

™ Treat consecutive delimiters as one

ata preview
flx. [. Holues Hacobean House Quzen Square Wincheoub{a
fi=. Faren EBaucke [Larks Nest Erovmhill Farm F. Woodch
fir=. Piana Beawver [The Malt House [Foulton Cirencest
Fir. [Philip Eeawver [The Malt House Poulton Cirencest
fir. P. Brigston Church Farmhouse Littledeay vI
. | B

Cancel | < Back | Mext = I Finish |

* Make the appropriate choice(s) as more than one can be selected.

* When you have chosen your delimiter the data display in the lower half of the
dialog box shows the effect.

* When this is as you want click-Next.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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* The Text Import Wizard (Step 3 of 3) dialog box is displayed.

Text Import Wizard - Step 3 of 3 EHE
This screen lets vou select each column and set

olurnn data Format
the Data Format,

& General
'General' converts numeric values to numbers, date © Texk
values to dates, and all remaining values ko text,  Date; IMDY ,l

" Do nok import column {skip)

Advanced... |

ata preview
Cehneral Copnergl Coneral Cohneral
[. Holues Hacobean House Quzen Square Wincheoub{a
Faren Eauckes [Larks Nest Erovmhill Farm F. Woodch
. piana Beawver ([The Malt House [Poulton Cirencest
fhilip Eeawver [The Malt House Poulton Cirencest
7. Brigston Church Farmhouse Littledeay vI
. | B
Cancel | < Back | Mexk = |

* You now select the data format for each of the columns. You can also decide
whether you wish to import a column or not.

* When you have made your decisions click on the Finish button to import the
text into your spreadsheet.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Importing From a Database

* Data in large organizations
may be held on “Mini” or
“Mainframe” computers

* MSQuery can be used
to capture (import)
this data

\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 1J

Importing From a Database

Background Often, in a corporate environment, data is not created and stored within Excel but may
be stored on mainframes or mini-computers. The data may be created and stored within
other dedicated database programs. Commonly used programs include Access, dBase,
Paradox, SQL Server;, Oracle or DB2:

Shipped with Excel is a separate program called Microsoft Query, which is supplied with
a separate user manual. This is an excellent tool for querying an external database.

Other methods of accessing external database files.include:

e Using the Open command located under the File drop down menu, and using the
List of type ' box, to select the following types of file:

" Lotus 123

¢ Quattro Pro

* _ Microsoft Works

. DBase

*  SYLK

» Data Interchange‘Format«(DIF)
. HTML files

. Previous versions of Excel

If your mini ormainframe application can output files in text format, again you can use
the Open cammand, and specify text files and use the . Text Wizard.

Applications such as Microsoft Access can save files in Excel format, which can be
loaded directly into Excel in the normal way.

Pivot Tables may be used for accessing and integrating external databases.

SAMPLE ONLY NOT TO BE USED FOR TRAINING

O Cheltenham Computer Training 1995-2000 - Tel: +44 (0)1242 227200 - Fax: +44 (0)1242 253200
Email: sales@cctglobal.com - Internet: http://www.cctglobal.com/



Importing Data

15

Excel 2000 Advanced

[0 1995-2000 - Cheltenham Computer Training

/

\\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 1/

Database Terminology
Data Sources \ \
Microsoft Query
Microsoft Query Add-in
ODBC Add-in
ODBC Driver
ODBC Manager
SQL

Database Terminology

Data Sources

The data source (defined in the ODBC Manager) informs the ODBC Manager
about the type of data being used and location.

Microsoft Query

A stand-alone program supplied with Excel. It acts as an interface allowing you to
make many gueries that are translated into SQL format.

Microsoft Query.
Add-in

Used to integrate Microsoft Query-and Excel.

ODBC Add-in It allows Excel to communicate with the ODBC Manager directly (without using the
Microsoft Query as an intermediary).
It also provides the SQL.REQUEST worksheet function, as well as providing an
Application Programmers Interface (API) / for application developers.

ODBC Driver The ODBC Manager uses the ODBC driver as an intermediate step.

ODBC drivers-supplied.with.Excel include;.Access;. dBase,.FoxPro, Paradox, SQL
Server, Oracle, Excel Worksheets and text files.

ODBC Manager

Open Database Connectivity. This is a Microsoft derived technology that allows
programs suchas Excelrand-Microsoft Query to'interface with a range of different
databases.

When you perform a Microsoft query, an SQL statement is sent to the ODBC
Manager. The:ODBC Manager then acts as an intermediary between the
application and the database.

This has the advantage that the same query may be used to access different
database servers, including SQL Server, Oracle, dBase or Paradox.

SQL

Structured Query Language. An industry standard language used for database
communication. Excel queries using Microsoft Query use SQL behind the scenes.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Using Microsoft Query

Microsoft Query allows
you to interrogate an
external database

\

Excel 2000 Advanced - Slide No. 1/

Using Microsoft Query

Background

Microsoft Query is a stand-alone program so may be started independently from Excel
by double clicking on the icon. It is much more convenient however to run Microsoft

Query from within Excel.

To Create aNew o
Query .

Make sure that Microsoft Query.is installed.
From the Data drop down menu, click on Get External Data .

» This displays a sub-menu from which you can select New Database Query . This
will display the Choose Data Source dialog box.

Choose Data Source

Databases | Queriesl OLaP Eubesl

LT
dBaze Files - Word
dBASE Files [not sharable)
dBASE Files”

Ewcel Files [not sharable)
E=cel Files™

Fo=Pra Files - Word®
FoxPra Files [not sharable]
FosPra Files*

[T [ Y TR Y

L

4

@l ¥ Use the Querny Wizard to create/edit queries

3

Cancel
Browse...
Options. ..

[WElErE

UGS

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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* Click on the OK button, to see the Create New Data Source dialog box.

‘what name do you want ta give your data source?

1
Select s drivern fan the type of datatisss pouwant to access:

2 | I~

[Elick Eannect atd enter anyintarmatian requested by the driver:

3 [Eanmest.. |

Select & default table for your data saurce optiona];
‘| =

I7 | Save myusen| B and passwornd i e data sauree defitiin

@ [ I Cancel I

* Inthe first dialog box field, enter a name for the new data source (in this case we
have entered My Data).

* Inthe second dialog box field, click on the down arrow and select the type of data,
in the example shown we have selected Microsoft Access Driver [*.MDB]

Create Hew Data 5ource

what niame do you want bo give pour data zource?
1. IMy Data

Select a driver for the type of databaze you want to access:

Click Connect and enter any infarmation requested by the driver:

3 Connect... |

Selent A deraui ekl e fariE o sta s auee (et

4 | Kl

I | Save myusen B and passywend it e data source defititian

@l [f | Canicel |

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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* Click on the Connect button. In this case you will see the dialog below.

ODBC Microsoft Access Setup E

[ate Sovree i Eme: I

E

D Escrptian |
Caticel |
— D atabaze

Database: Help

Create... | Bepair... Compact... |

Advanced...

i

— Spstem D atabase

¥ Mone
" Database:

Gystem Mataliase. |
DOptionzs»

» Click on the Select button, and you will see the following dialog box.

Change to the folder containing the database that you wish to use. In this case we
will use the NorthWind database, which is a sample database supplied with Access.
You will normally find this in the following location.

/Program Files/Microsoft Office/Office/Samples/Northwind.mdb

If cannot find this file ask your tutor for assistance.

Select Database
Database Mame Directories:
INnrthwind.mdb chhofficelsamples -

Cahicel |
ADDREOOKMDE & [ e = |
CONTACT.MDE [== Program Files
NVENTEMDE [= Microsoft Office il
%DSHICBI [~ Eead Only
amples [ Exclusive
LI £ originals j
List Filez of Tope: Dirives:

Access Databases [".mlj I = o PANRIE j wl

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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» Click on the OK button, and you will see the following dialog box.

ODBC Microsoft Access Setup

[ata Saunce W ame: I ak. |
Wescrption: |
Cancel |
 Database
Databasze: b W0ffice\SamplesiMorthwind mdb Help |
: 5 Create. .. | Bepair... Compact... |
Advanced... |
— System D atabase
o None
" Database:
Susten U atatase, |
Dptiongs> |

» Click on the OK button, and you will see the following.

Create New Data Source EE

“What name do pou want to give pour data source?

1. IMy Data

Select a driver for the type of databaze vou want to access:
2 IMicmsoﬂ Accexs Driver [*.mdb) j

Click Connect and enter any information requested by the driver;

o WProgram Files\Microzoft

Select a default table for your data source [optional):
o 5

[~ Save my user ID and password in the data source definition

@l Qg | Cancel |

* Click on the OK hutton, and you will see the following.

Chooze Data Source

Databazes | E!uetiesl OLAP Eubesl
Excel Files [not sharable] d Cancel |
Excel Files*

FosPro Files - Word®

FaxPra Files [nat sharablz] Browse... |
FosPro Files®

M5 Aecess 97 Database [not sharable) Options.... |
M5 Aecess A7 Database®

M5 Access Databaze Delete |

L

Tk Filee Feemt e el

Ell ¥ Use the Query wizard to creatededit queries

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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» Click on the OK button and you will see the following dialog box.

Query Wizard - Choose Columns

“what columng of data do you want to include in vour query?

Available tables and columns: LColumn in your query:

Alpis L k3 |
Categones -
Category Sales for 1337 —<I J
Current Product List &4 |

Customers

Customers and Suppliers by City

Fronlnuee S ales hu Conntro LI

Preview of data in selected colurnn:

@l EreviewNowl Options... | < Bach | fEsts | Cancel I

1HEEEHEBE

» Make sure that Categories is selected and then click on the arrow that points to the
right. You will see the following.

Query Wizard - Choose Columns
“What columns of data do you want to inchude in your query?
Available tables and columns: LColumng in your query:
Alphabetical List of Products - _>| Categary|D j
R ] CategorName |
Cateqaory Sales for 1997 Piifﬁr[.lep“on
Current Praduct List << |
Customers
Customers and Suppliers by City
# Franlnuee Sales ho Coowtro LI

Preview of data in selected column:

@l Bresrew e Options... < Back I Mest > I Cancel

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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» Then select Category Sales for 1997 and click on the arrow that points to the right,
you will see the following.

Query Wizard - Choose Columns

What columng of data do pou want ta include in your quen?

Ayeailable tables and columns: Columme in pour query:
Alphabetical List of Products - > I CategorylD j
Categaories CategoryMame j
" y i | Description
: Ficture
Current Praduct List ad | CategoryMame
Custorers CateqanyS ales
Cuztomers and Suppliers by City
& Fronlnues S ales hu Coontu j

Prewiew of data in zelected caolumn:

@ Erewiews Nowl Options... | < Back | Mesit » | Cancel |

» Click on the Next button and you will see the following dialog box.

Query Wizard - Filter Data

Filter the data to specify which rows to include in your query.
If pou dan't want to filter the data, click Mext.

LColurnt to filker: Only include rows where:

 Lateqon L)

Categaoryt ame I j I j

Dezcription

Picture £ | AT 0

CateqaryM anne

CategonySales I j I j
) fmdl €0
LT [

@l < Back I Mest > I Cancel |

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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» Click on the Next button and you will see the following dialog box.

Query Wizard - Sort Drder

Specify how pou want your data sorted,
IF pow don't want to sort the data, click Mest.

Sort by -
R - -~
) Descending
Thesm by
I j ) bscending
) Descending
Tikier by
I j ) Eecending
) Descending |

@I < Back I Mest > I Cancel |

» Click on the Down arrow next to the Sort by field, and from the list displayed select
CategoryName .

» Click on the Down arrow next to the Then by field, and from the list displayed select
CategorySales .

» The dialog box is now as illustrated below.

Query Wizard - Sort Order E

Specify how you want pour data sorted,
If pow don't want to zort the data, click Mest.

Sort by
CategoryMame

j & Ascending
" Descending

Then by

& Ascending
" Descending

I j ) bscending
| Mescending

YI

@I ¢ Back I Mext > I Cancel |

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Click on the Next button.

Query Wizard - Finizh

—wWhat would you lilke to do next?

& Return Data bo Microsoft Excef

" Wiew data or edit query in Microsoft Query

¢ Create an OLAP Cube from this query

Save Query... |

@l <Back [ Finish |

Cancel |

Ensure that the Return Data to Microsoft Excel
the Finish button.

box is selected, and then click on

Click on the Finish button. You will see the following dialog box.

Returning External D ata to Microsoft Excel EHEi

‘Where do vou wank ko put the data? ok
%" Existing worksheet:

" Mew worksheet
¢ PivotTable report

Y

Cancel

Properkies. ..

Parameters. .,

HA;

Click on the OK button-and the following-data will be returned.to your Worksheet.

A B T

|5|m|m|w|m‘m|:—-|m|m -

3

CategorylD CategoryName Description

1 Beverages Soft drinks, coffees, teas, beers, and ales
2 Condiments

3 Confections

4 Dairy Products
5 Grains/Cereals
6 Meat/Poultry
7 Produce

8 Seafood

Dessers, candies, and sweet breads
Cheeses

Breads, crackers, pasta, and cereal
Prepared meats

Dried fruit and bean curd
Seaweed and fish

Data
#

2]

5 e

Sweet and savory sauces, relishes, spreads, and seasonings

| D | E \

CategoryName CategorySales

Beverages 102074.29

Condiments 55277 .56

Confections a0824.11

Dairy Products 114749.75

Grains/Cereals 5554882

Meat/Poultry 81338.06

[x]] Produce 53019.95

9 ﬁj 3] Seafood B5544.19

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Review Questions

Review Questions - How Would You ...

1. Import text into a sheet using the Text Wizard?
2. Import data from a Database?
3. Create a New Query?

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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“What If?” Utilities

Learning Module Objectives

When you have completed this Use Goal Seek
learning module you w ill h ave « Use Graphical Goal Seeking
seen how to: » Use the Scenario Manager

* View alternative scenarios

» Use Solver

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Excel 2000 “What if?” Type Ultilities
Goal Seek

— Allows you to find the correct input

* Scenario Manager
— Allows you create, manipulate and

Solver
— Allows you to find the best solution to complex problems which

\

to produce the desired output

save a humber of different scenarios
which produce different results

revolve around the manipulation of multiple variables and
constraints

\\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 1/

Excel “What If?” Type Utilities

Background

Goal Seek

Scenario
Manager

Solver

Excel provides a number of tools to help you find answers to “what if” type
guestions.

Allows you to find the:correct input'to’produce the desired output. Simple to use,
but limited in power and flexibility.

Allows you create, manipulate and save a number of different scenarios that use
different input variables which produce different results. Simple to use, limited in
power and flexibility:

Allows you to find the best solution to complex problems which revolve around the

manipulation-of multiple variables and constraints.~Harder-to-use, but very powerful
and extremely flexible.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Goal Seek

* Goal seeking is the means to say “This is the
value that | want to achieve - change this input
value in order to do so”

Goal Seek BHE i

Set cell: iCS j‘.’
To value: ’SDEIEIEI
B changing cell: I$C$3 j‘J

\\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 1J

Goal Seek

Background

Goal Seek -‘an
example

When using a spreadsheet we regularly know the end result we require and have
to work out the values to reach this result. The Goal Seek command will allow us
to do this in a very easy manner.

You wish to purchase a car, your current vehicle is worth $4,000 in part exchange.

This part exchange value plus your cash down payment of $1000 makes up the
20% deposit required towards the cost of the new car.

A spreadsheet to show this is illustrated and shows that you can afford a new car
costing $25,000. The only formula in the spreadsheetiis in cell'C5:

=(C3+C4)*5
5 | =| =(C3+C4)5
A E [ C |
1
2]
Down payment required
=N on the new car % 1,000.00
Part exchange value of
4 your old car $ 4,000.00
Total car price that you
8 can afford $25,000.00

If we suppose that you have seen a car costing $30,000 your question would likely
be. What will my cash down payment now need to be? You could experiment by
entering various values into the Down Payment cell or you could use Goal Seek.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Make cell C5 i.e. the total car price that you can afford  your active cell (by
clicking on this cell).

Start Goal Seek by opening the Tools menu and selecting Goal Seek.

Enter 30000 in the To value text dialog box and the press the Tab key to
move to the field in the Goal Seek dialog box called By changing cell .

| Goal S5eek 7] %]
Down payment required } H
on the new car 1$_1,000.00 } | set cel: 5 %
Part exchange value of
To walue: W
your old car $ 4,000.00 B
Bv changing cell: $C43 =3

Total car price that you

can afford $25,000.00
(a]4 I Cancel |

* Use the mouse to click on the cell C3. This means that when we click on the

OK button, the contents of this cell will change to fit in with our desired result.

* Click OK. The Goal Seek Status dialog box is displayed and the value of

your Down Payment has changed to $2000.00. This is the new amount you
would have to pay to obtain this car.

Goal S5eek Status l

Goal Seeking with Cell C5
found a solutian.

Cancel
Target value: 30000

Currert value:  $30,000,00 Skep

Pause

_ el |
R
e

» If you click OK these changes are accepted or if you click Cancel these
changes are not accepted.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Graphical Goal Seeking

Drag here to

I
30,000.00 Goal Seek!

22,000.00
20,000.00
15,000.00
10,000.00
$5,EIEI$I;I n

@ Set cell: 5

qﬁﬂ.. .-5\‘5"5 ¢\'b To walue: ]21?00
:;FJ - '-{a By changing cell: I EEI

\

Cancel |

1
\\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 1/
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Graphical Goal Seeking

Background

We have seen the text-based method for carrying out a goal seek, there is
however another method of carrying out this task using a chart.

We will'use the sameexample that'we used fortext based goal seeking,i.e.

working out what new car we can.afford!

If we suppose that you have seen a car costing $14,000 your question would likely

be. What will my cash down payment now need to be?

» First select the data as illustrated/below.

SAMPLE ONLY NOT TO BE USED FOR TRAINING

A B I
2
Down payment required
3 on the new car $1,000.00 |
Part exchange value of |
4 our old car $4,000.00
otal price that you can
_a afford to buy a new car | $25,000.00 l
=

O Cheltenham Computer Training 1995-2000 - Tel: +44 (0)1242 227200 - Fax: +44 (0)1242 253200

Email: sales@cctglobal.com - Internet: http://www.cctglobal.com/



30

“What If” Utilities

[0 1995-2000 - Cheltenham Computer Training Excel 2000 Advanced

*  Click on the Chart Wizard icon in the Standard toolbar and when the Chart
Wizard dialog box is displayed, as shown below, click on the Finish button to
create a bar chart using default formats.

Chart Wizard - S5tep 1 of 4 - Chart Type ’

Standard Types | Cuskom Types |

Chart tvpe: Chart sub-tvpe:

Zolumn

@ Doughnut

@r Radar
| surface B
®: Eubble

[ﬁ;ﬁ Stack :J

= S (Scatker)
19 0. A

Clustered Column, Compares values across
cakegories.

Press and hold to wiew sample |

@I Cancel < Back | Mexk = I Einish |

The bar chart produced should resemble that shown below.

] | |
$30 00000
$25 (00,00
$20 000,00 -
§15,000.00 —
$10'000.00 -
m 500000 — n
g000 +=—
T T T
2L £28
= o — 4 '
[ [T m o =
[ 'E,' E I
|_ [}
| | | ||

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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» Click once on the column representing the Total price that you can afford
You will see the column change as illustrated below.

%30 000.00
$25 000,00
%20 000.00 -
§15,000.00 =
%10'000.00 L
%5 000,00 -
5000 === TN
= BT
£22 288
= O — o
O &3 mm =
[ B 'E.' _E o
|_ (o]

You will see a small rectangular square in the center of each column.

» Click once on this column again, and the display will change as illustrated

below.
$30,000.00
%25 000,00
$20'000.00
%15 000,00
%10'000.00
$5.000.00
g0.00 — [

== L _ B

s2E £ 2.8

O _ o

] oo L

o = = _E i

|_ [ ]

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Move the mouse pointer to the top of this column and then drag and drop the
column up or down and required. You will see a small rectangular box is
displayed, which indicates the value that you have dragged to. In the example
shown, we have dragged to $14,000.

§30,000.00 $14,000.00 |
%25 000.00
$20'000.00 J: |
e 4 =
$5.000.00 5
$I:II:":| = T I_l | 1 I
T 8 = =
EEE g8
OFE =R o
= B L o
= O

The Goal Seek dialog box appears ready for you to enter a cell reference into
the By changing cell text box.

Click on the cell C3, to place this value into the By changing cell text box, as
illustrated below.

Down payment required | H

on the new car ! rﬁ],_l_]gl]___l_]_l_]__s Goal Seek Il E3

Part exchange value of Set cell = =

your old car $4,000.00

Total price that you can To value: IHDUU

afford to buy a new car $25,000.00 | | By changing cell: |$C$3| q‘:]
Ok I Cancel |

§30,000.00

§25,000.00 ‘

$20,000.00 -—‘ L

Click on the OK button to display the Goal Seek Status dialog box, illustrated

below.
Goal Seek Status [ 2] i

Goal Seeking with Cell C5
Found a salution,

Cancel

- ]
L e |
_pase |

Target value: 14000
Current value:  $14,000.00 Step

Pause

Click on the OK button to accept these changes and exit from the Goal Seek
Status dialog box.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Scenario Manager

review later

What if I Juggle

* You will frequently want to look at a number of
differing options within your spreadsheet

* The Scenario Manager allows you to
do so and keep your scenarios to

the figures?

\\ © Cheltenham Computer Training 1995-2000
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Scenario Manager

Background

Scenario

Manager - an

example

The Scenario Manager is similar to Goal Seek. However it allows you to change
multiple cells in order to see changes (not just one as is the case with Goal Seek).

One of the advantages of scenarios‘is'that they are kept for later reference and can
be printed in'summary form.

Look at the illustration below. It shows a sheet that is calculating yearly payments
on specific items this year and details expected percentage increase in these
costs. You may be.interested.in.knowing-how the figures are effected if we make a
range of assumptions about how each item might increase.

A | B | ¢ D | E |
This Expected | Additional cost caused
years percentage by this percentage
2| costs increase increase
=R Rent $30,000 10 $3,000
4 Staff $95,000 10 %9500
| 5 | Energy $20,000 20 $4,000
B Other $55,000 5 $2.750
7 Totals $200,000 $19,250

The cell E3 contain the formula =C3*D3%
The cell E4 contain the formula =C4*D4%
The cell E5 contain the formula =C5*D5%
The cell E6 contain the formula =C6*D6%
The cell E7 contain the formula =SUM(E3:E6)
The cell C7 contain the formula =SUM(C3:C6)

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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We are going to create scenarios for the following situations:

* Staff Low - 2.5%

» Staff Low, Energy High - 2.5%, 35%

* Once the above data and formulas have been created.

» Select the changing cells, in this case the range D3:D6.

* Click on the Tools drop down menu and select the Scenarios option.

» If no previous scenarios have been created you will see the following dialog

box.

Scenano Manager

Mo Scenatios defined, Choose Add ko
add scenatios,

Changing cells:

Comrmenk:

S

Close

il

Delete
Edit...

Merge...

_ belte |
I
_tere... |
JELLET

SUMMErY. ..

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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»  Click on the Add button and the Add Scenario dialog box is displayed.

Add Scenarno EE |
Scenario name:
hanging cells:

|o3:06 By

Zkrl+click cells to select non-adjacent
changing cells.

Cornrnenk:
Created by Mewman on 15022000 ;I
| -
Prokeckion
¥ Prevent changes [ Hide

Ik Cancel

«  Enter a name for the scenario you are about to create. In this case enter the
name Staff Low into the Scenario name text box and then click on the OK
button. The Scenario Values dialog box will be displayed as illustrated below.

Scenano Yalues [ 2] ’
Enter walues For each of the changing cells.
L 4043 |

Cancel I
2 $D$4 |10
3 4045 [20 Add
4 $D%6 |5

» The'percentage rise-in staff-costs are located.in-cell D4 and we need to change
the contents of this cell. In the dialog box enter a low value, i.e. 2.5 in the text
box, next to $D$4.

SAMPLE ONLY NOT TO BE USED FOR TRAINING

O Cheltenham Computer Training 1995-2000 - Tel: +44 (0)1242 227200 - Fax: +44 (0)1242 253200
Email: sales@cctglobal.com - Internet: http://www.cctglobal.com/



36

“What If” Utilities

[0 1995-2000 - Cheltenham Computer Training

Excel 2000 Advanced

* Click on the OK button and you will be returned to the main Scenario Manager

dialog box, as illustrated below.

Scenano Manager
Scenarios:
Close |
add... |
Delete |
= Edit... |
hanging cells: Merge. .. |
§0$3:$096
Summary. .. |
cCarmmenk:

reated by Mewman on 150022000

*  Next we will add a second scenario where staff cost increases are low, but
energy costs increases are high. Click on the Add button and enter the name
for the next scenario, in this case Staff Low Energy High

Add Scenarno EE |

Scenario name:

ISI:aFF Low Energy High

hanging cells:

|o3:06

Zkrl+click cells to select non-adjacent
changing cells.

Cornrnenk:

Y

Created by Mewman on 15022000

Y

SE

Prokeckion
¥ Prevent changes

[ Hide

[ |

Cancel

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Click on the OK button, and change the two cells as below.
l.e. in the $D%$4 text box enter 2.5
l.e. in the $D$5 text box enter 35

Scenano Yalues [ 2] i
Enter walues For each of the changing cells.
1; $0$3 |10

Cancel 1
2 $D$4 |2.5
3 4045 [35 Add
4 $D%6 |5

Click on the OK button.

You will be returned to the main Scenario Manger dialog box. You can go on
adding different scenarios in the way outlined above. In this case we will
content ourselves with just these two scenarios.

We have set up two scenarios. To see the effect of one of these scenarios,
select the scenario from the main Scenario Manager dialog box.

In this case we have selected Staff Low Energy High

Click on the Show button.

This Expected | Additional cost caused
years percentage by this percentage
costs increase increasge
Rent $30,000 10 $3,000
Staff $95 000 $2.375
Energy $20 000 $7 000
Other $55 000 b2 750
Totals $200 000 $15 125

Scenano Manager

7]
Shiow I

Close |

SCenarios:

Skaff Low -
iSkaff Low Energy High E

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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To view an .
alternative
scenario

Rent
Staff

Energy
Other
Totals

Excel 2000 Advanced

In this case select the Staff Low scenario from the Scenario Manager and
click on the Show button. The data will change as illustrated below.

This Expected | Additional cost caused
YEars percentage by this percentage
costs increase increase
$3,000
b2 375
$4 000
52 750
F200,000 B2 125
Scenario Manager EE3
Close |

* Click on the Close button to close the Scenario Manager dialog box.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Solver

* Most versatile “what if” tool
* Can handle many different variables

* Where possible Solver will produce
the optimum answer

\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. ZJ

Solver

4 N

Solver Terminology

* Target Cell
— The cell that will be set to a value, maximum or minimum.
Often this cell is where you specify the maximum cost of a
project
* Changing Cell
— The cells that Solver will change the contents of to achieve the
desired objective

* Constraints
— Contains the changes that Excel will make

\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. ZJ

Solver Terminology

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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* We need to purchase as many new cars as

* We need a mix of small, medium and large cars

Solver - An Example

possible

We have a

— Our total budget is limited to $500,000

We need at least 4 small cars

We need at least 3 medium sized cars

We need at least 2 large sized cars

The number of cars must be a whole number

\

number of constraints however:

\\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. ZJ

Solver — An Example

First construct
your
spreadsheet

* In this example we have a budget to purchase as many new cars as possible for
the new company car fleet. We need a mix of small, medium and large cars.

We have a number of constraints however:

s Our total/budget is limited to $500,000

*  We need at least 4 small cars

*  We need at least 3 medium sized cars

* We need at least 2 large sized cars

* " Also if weare going'to let the computer:calculate'a'mix of the different number of
cars to meet our requirements and budget, then.we will.have to specify to Excel
that buying part of a car is no use, i.e. the numbers of each type of car bought
must be whole numbers (integers)!

* We have constructed-the following data:

Al

B | C | D | E |
The Mew Car Fleet
Class of Car Cost per Car Mo of Cars in Class Total price/class
Small $14 000 1 $14,000
Medium Sized §20,000 1 $20,000
Large £40 000 1 $40,000
Total cost of the car fleet §74 000

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Formulas and functions used:

In cell E4 we have used the formula =C4*D4

In cell E5 we have used the formula =C5*D5

In cell E6 we have used the formula =C6*D6

In cell E8 we have used the function =SUM(E4:E7)

When you have entered all the data, formulas and functions as outlined above,
click on the cell ES8.

Click on the Tools drop down menu, and select Solver. You will see the Solver
dialog box, as illustrated below.

Solver Parameters

i

Set Target Cell: Solve

Equal Ta: & Max O Mo O Walue of: |':'
~Bv Changing Cells:

~Subject to the Constrainks:

Close

[

ik |
o

Guess

Options

||

Change

;I Delete

Reset all

Help

Make sure that the text box, Set Target Cell contains $E$8. If you selected this
cell prior to starting Solver this cell reference should be entered here
automatically.

Click on the Value'of button and'in the text box to the side of it enter the number
500000 (this is setting the. maximum size.of our budget). The dialog should
appear as illustrated below.

Solver Parameters

i

Set Target Cell: $E$S B Solve
EualTo:  CMax Mo Yalueof:  |500000] Cose |
By Changing Cells:

! _=_|§J GUess
—Subject ko the Constraints: Options

bk b
T

Change

:,J Delete

Reset Al

Help

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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* Next we need to decide which values need to change in order to fit our
requirements. In this case the values to be changed are the numbers of each
class of car that we can afford.

* Click in the By Changing Cells part of the dialog box

 Either enter the information required by typing in $D$4:$D$6

OR use the mouse to drag across these cells D4 to D6 and the cell reference
will be entered automatically.

Solver Parameters

i

Sef Target Cell: $E$5 % Solve
Equal To: ' Max 'S Min i+ Yalue of; IEIIIIIIIIIIIIEI Close I
B Changing Cells:

;$D$4:$D$E~| _=_|§J GUEsS
~Subject ko the Constraints: Options

ok b
T

Zhange !

_ﬂ Delete

Reset Al

Help

* Next we need to tell Excel what constraints we have, such as limited budget etc.
* Click on the Add button and you will see the Add Constraint dialog box, as
illustrated below.

Add Constraint
Cell Reference: Constraint:
Il E = =] 3 |

[0]4 I Cancel I Add I Help

» To enter therestraint that we have a budget limited to $500,000 , in the Cell
Reference text box enter the cell $E$8.

» Then click on the down arrow in the center part of the dialog box, and select the
= symbal.

* In the Constraint -part of the dialog, enter the number 500000.

» ' The dialog box will resemble that shown below.

Add Constraint
Cell Reference: Constraint:
[sE5a =] - =] [soooo =]

[0]4 I Cancel I Add I Help |

SAMPLE ONLY NOT TO BE USED FOR TRAINING

O Cheltenham Computer Training 1995-2000 - Tel: +44 (0)1242 227200 - Fax: +44 (0)1242 253200
Email: sales@cctglobal.com - Internet: http://www.cctglobal.com/



“What If” Utilities

43

Excel 2000 Advanced

[0 1995-2000 - Cheltenham Computer Training

To force Excel to realize that we can not buy part of a car just whole numbers of
cars we need to add another constraint.

Click on the Add button (NOT THE OK BUTTON).

In the Cell Reference text box either enter the information $D$4:$D$6

OR use the mouse to drag across these cells D4 to D6 and the cell reference
will be entered automatically.

In the central part of the dialog box, click on the down arrow and select
int which will force Excel to only use integer (i.e. whole) numbers in the selected
range. The dialog box will look as below.

Add Constraint
Cell Reference: Constraint:
[$Dg4:9046 53| M Iinteger =k]

[0]4 I Cancel I Add I Help |

Next we need to tell Excel that we must have a minimum of four small cars.
Click on the Add button.
In the Cell Reference text box either enter the reference $D$4

OR use the mouse to click on the cell D4 and the cell reference will be entered
automatically.

Select >= from the central part of the dialog box.
In the Constraint box, enter the value 4.

The dialog will be as illustrated below.

Add Constraint
Cell Reference: Constraint:
[404 =% S B 3 |

[0]4 I Cancel I Add I Help |

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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* Next we need to tell Excel that we must have a minimum of three medium sized
cars.

* Click on the Add button.

» Inthe Cell Reference text box either enter the reference $D$5

OR use the mouse to click on the cell D5 and the cell reference will be entered
automatically.

» Select >= from the central part of the dialog box.
* Inthe Constraint box, enter the value 3. The dialog will be as illustrated below.

Add Constraint

Cell Reference: Constraint:

[s45 - =I5 =]
[0]4 I Cancel I Add I Help |

* Next we need to tell Excel that we must have a minimum of two large cars.
* Click on the Add button.
» Inthe Cell Reference text box either enter the reference $D$6

OR use the mouse to click on the cell D6 and the cell reference will be entered
automatically.

» Select >= from the central part of the dialog box.
* Inthe Constraint box, enter the value 2. The dialog will be as illustrated below.

Add Constraint

Cell Reference: Constraint:

4046 =% S B B 3 |
[0]4 I Cancel I Add I Help |

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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We are now ready to solve the purchasing problem.
Click on the OK button and you will see the dialog box below.

Solver Parameters

i

Set Target Cell: H Solve
Equal Ta: Max (" Mn  Yalueof: 500000 - |
B Changing Cells:

;$D$4=$D$5 _}J GUess
Subiect to the Constraints: options

D44 =4
0444046 = inkeger
$045 ==3 Change

D86 »=7
:-I Delete

!
I

Reset Al
$E$E = 500000 —

Help

Click on the Solve button. After a short time you will see the following dialog
box.

Solver Results HE

Solver Found a solution. Al constraints and optimality
conditions are satisfied. Reparks

Py
" Restore Original Yalues
[8]4 I Cancel I Sawe Scenatio... I Help I

Click on the OK button to accept the solution.

Thedata-in.your-workbook-will-now-be-as illustrated below:

A B | C | D | E |

1 The New Car Fleet

2
Z Class of Car Cost per Car No of Cars in Class Total price/class
4 Small $14,000 10 $140,000
5| Medium Sized $20,000 ] $120,000
B | Large $40,000 B $240,000

7
E Total cost of the car fleet $500 000

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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~

Review Questions

Review Questions - How Would You ...

Use Goal Seek?

Use Graphical Goal Seeking?

Use the Scenario Manager?

View alternative scenarios?

ISR L

Use Solver?

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Macros and Custom Controls

Learning Module Objectives

When you have completed this
learning module you w ill h ave
seen how to:

Record a Macro

Assign a macro to a shortcut key

Run a macro using the Tools Macro command
Run a macro assigned to a shortcut key

Create option buttons

Attach a macros to a button

Assign a macro to a button which already exists
Format the text inside a button

SAMPLE ONLY NOT TO BE USED FOR TRAINING

O Cheltenham Computer Training 1995-2000 - Tel: +44 (0)1242 227200 - Fax: +44 (0)1242 253200
Email: sales@cctglobal.com - Internet: http://www.cctglobal.com/



48 Macros and Custom Controls

[0 1995-2000 - Cheltenham Computer Training Excel 2000 Advanced

4 N

What are Macros?

* A macro is a series of instructions which enable
you to make Excel 2000 perform commands or
actions for you

* Excel 2000 can repeat a task at any time by using
a macro

* They are useful for complex or repetitive tasks
which you perform regularly

\\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. ZJ

What are Macros?

Background If you are not a programmer then do not worry! Macros do not necessarily involve
programming! The easiest way to create a new macro is to have Excel record your
actions and then store these actions as a macro.

Macros can be played back at any.time or modified at any time.

SAMPLE ONLY NOT TO BE USED FOR TRAINING

O Cheltenham Computer Training 1995-2000 - Tel: +44 (0)1242 227200 - Fax: +44 (0)1242 253200
Email: sales@cctglobal.com - Internet: http://www.cctglobal.com/



Macros and Custom Controls 49

Excel 2000 Advanced

[0 1995-2000 - Cheltenham Computer Training

/

¢ Enter the details into the

. |
Record Macro dialog box, otop FI'Z"-E
click on OK and start =
. H
recording! W | HH
—TTI— e T —
Click on
MEED mEmE this button
IMyMach to stop
Shorteut key: Store macro in: recording
Ctr|+|_ IThis Wworkbook j
Description:

To Record a Macro \

Macro recorded 157022000 by Mewman

oK I Cancel
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To Record a Macro

To assign a
macro to a
shortcut key

Select Macro from the Tools menu.

Select Record New Macro to display the Record Macro dialog box.

Enter a name for the macro in the Macro name text box.

The default description is displayed in the Description | text box, and.contains
the date and user.name. If required, click in the Description text box and enter
a new description.

To begin recording, select OK.

Start performing the actions you want the macro to record. Excel will record
them.

To stop recording, click the Stop Recording button on the Stop Recording
toolbar, or choose the Tools Macro Stop Recording: command.

From the Tools menu, choose Macro and then Macros to display the Macro
dialog box:

Click on the macro name to which you want to assign a shortcut key.

Select the Options button to display the Macro Options  dialog box.

Type a letter into the Ctrl+ text box. This key combination will be used to
invoke the macro.

Select. OK to.return to the Macro dialog box.

Click on the Close/icon in the top right of the dialog box.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Running Macros

\

=
Macras in: all Open Workbooks j

Descripkion
Macro recorded 15/02/2000 by Mewman

n

Cancel

Skep Inko

Edit

Create

Pk

Delete

opions. ..
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Running Macros

To run a macro * From the Tools menu, select Macro and then Macros to display the Macro

using the Tools dialog box.
Macro » Click on the name of the macro you wish to run in the Macro Name list box.
command « /7 Select the'Run button.

To run a macro * Press Ctrl+ the letter which you assigned.
assigned to a
shortcut key

SAMPLE ONLY NOT TO BE USED FOR

TRAINING

O Cheltenham Computer Training 1995-2000 - Tel: +44 (0)1242 227200 - Fax: +44 (0)1242 253200
Email: sales@cctglobal.com - Internet: http://www.cctglobal.com/



Macros and Custom Controls 51

Excel 2000 Advanced [0 1995-2000 - Cheltenham Computer Training

/Creating a Button in a Worksheet and \
Assigning a Macro to it

— Create a button using the Forms toolbar, and assign a macro to it

Farms

Ax abl

M |F @ EBEE
s |z E

/3 [

—l Button 1 ‘

Button Icon
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Creating a Button in a Worksheet and Assigning a Macro to it

To create a * To display the Forms toolbar, right click on any toolbar that is visible and from
button and the pop-up menu that is displayed select Forms .
assign a macro » Select the Button icon from the Forms toolbar.
to it /. To create a button, click and drag on the' worksheet.
¢ When you release the mouse-button, the Assign Macro dialog box will be
displayed.
» Click on the Record button, and the Record Macro dialog box will be
displayed.

[ Enter a:name for'the'macro; in‘the‘Macro nametext box.

*  Click on the OK button.

*  Record your'macro in the normal way, and click on the Stop Macro button
when you have finished.

» To rename the button text, right click on the button and select Edit Text from
the pop-up'menu:

e To run the.macro simply click on the button.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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/ Attaching Macros to a Button \

* You can assign a macro to a button at any time

— Click on the button using the right-hand mouse, and select Assign
Macro

\\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 2/

Attaching Macros to a Button

To assign a
macro to a
button which
already exists

To delete a
button from a
worksheet

Click on the button with the right-hand mouse button to display the shortcut
menu.

Select Assign Macro to display the Assign Macro dialog box. From the
Macro name list box, choose a macro or record a new one using the'Record
button.

To assign the macro to the button, select OK. If thereis already a macro
assigned to the button, it will be changed.

Display-the:shortcut-menu-by-clicking-on the button yourwant to delete with the
right-hand mouse button.

Click on the gray area surrounding the box.

To delete the button, press the Delete key.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Drawing, Editing and

Formatting Buttons

You can create buttons which may be inserted into an
Excel 2000 worksheet and macros can then be attached
to them

If you click on these buttons you can run the macro (or
any other action associated with the button)

Make sure that you know how:
— Todraw a button on a worksheet
— To change a button name
— To format the text inside a button

\\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 3/

Drawing, Editing and Formatting Buttons

To draw a
button on a
worksheet

To change a
button name

* Onthe Forms toolbar, click on the Create Button icon.

»  Click on the worksheet, and drag diagonally to create a button of any size. The
Assign Macro dialog box will be displayed to allow you to attach a macro to
the new button.

» If you do not have a macro, you-can either record one by choosingthe Record
button, or click the Cancel button to remove the dialog box.

« If the macro you want to use is displayed in the Macro name text box, click on
it and choose OK to attach it to the button.

NOTE: Clicking on an existing button with the right-hand mouse button, allows you
to move it via a shortcut menu. If you click on the button’s border with the left-hand
mouse button'you can drag the button to'a new location. If there is no macro
attached to the button, you can drag it with the left-hand mouse button.

»  Click on the button with the right-hand maouse button to display the shortcut
menu.

* Remove:the shortcut menu'by clicking on the-face of the button with the left-
hand mouse button. This lets Excel know that you want to edit the button.

»  Click on the existing title text with the left-hand mouse button to highlight the
title.

« Type in a'new title and click on a cell to deselect the-button.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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To format the * To display the shortcut menu, click on the button with the right-hand mouse
text inside a button.

button * From the shortcut menu, choose Format Control to display the Format

Control dialog box.

» To select a font and other types of formats for the button text, choose the Font
tab.

» To align the text inside the button, click on the Alignment tab. You can also
change the orientation of the button text.

» Select OK when you have finished.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Review Questions

Review Questions - How Would You ...

Record a Macro?

Assign a macro to a shortcut key?

Run a macro using the Tools Macro command?

Run a macro assigned to a shortcut key?

Create option buttons?

Attach'a macros to a button?

Assign a macro to a button which already exists?

OIN|o G~ W INE

Format the text inside a button?

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Customizing Excel

Learning Module Objectives

When you have completed this » Use the View Options
learning module you w il h ave + Use the Calculation Options
seen how to: « Use the Edit Options

* Use the Transition Options

* Use the General Options

* Use the Custom Lists Options

* Use the Chart Options

» Use the Color Options

* Customize a toolbar

* Reset a toolbar which you have customized

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Shiow

Customizing Excel 2000 - Options

I Cuskom Lists I Chart I Calar
| Calculation I Edit I General

[V status bar

IV Formula bar

IV windows in Taskbar

‘Window options

Comments

" None ' Comment indicatar orly " Comment & indicatar
Objects

& Shaw all " Show placeholders " Hide all

™ Page breaks

I Formulas IV Qutline symbols
IV Gridiines V' Zero values
Color: I Automatic - l

V' Row & column headers

|+ Horizontal scroll bar

¥ wertical scroll bar
[V sheet tabs

[ ]

Cancel
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Customizing Excel 2000 - Options

To view Excel .
Options * The available tabs are as follows.
View Options
Custaom Lisks I Chart
Calculation | Edit

Shaw

| Colar
| General

¥ Status har

¥ Eormula bar

IV windows in Taskbar

Comments

€ MNone & Comment: indicator only € Comment & indicator
Obijects

& Shaw all " Show placeholders " Hide all

window options

™ Page breaks
™ Farmulas
IV Gridlines

Color: I Aukomaktic vl

W Fow & column headers
W Cutine symbals
W Zero values

¥ Harizonkal scrall bar
W ertical scroll bar
W sheet kabs

[ o ]

Cancel

SAMPLE ONLY NOT TO BE USED FOR TRAINING

Click on the Tools drop down menu and select Options command.
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Calculation Options

Edit

USED
TRAINING

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Transition Options
View | Calculation | Edit | General
Custom Lists | Chart I Color
Save Excel files as: IMicrosoFt Excel Warkbook, j
Settings
Microsoft Excel menu or Help key: !

% Microsoft Excel menus
™ Lokus 1-2-3 Help

I™ Transition navigation keys

Sheet Options

I™ Transition Formula evaluation
I™ Transition Formula entry

[a]4 I Cancel I

General Options 7] =]
Transition I Custom Lists I Chart | Color |
Wigw I Calculation | Edit
Sekkings
™ RIC1 reference style I™ Prompt for workbook properties
™ Ignore other applications I™ Provide feedback with sound

I™ Zoom on rall with InteliMouse

W Recently used file list: |9 5‘ entries Web Options. .. |
Shests in new workbaok: |3 E‘

Standard fonk: I.C\rial LI Size: IID ;I
Default file location: IC:'l,My Diocurments

Alternate startup file location: I

User name: IDa\-'id Murray

Ok I Cancel

SAMPLE ONLY NOT TO BE USED FOR TRAINING

O Cheltenham Computer Training 1995-2000 - Tel: +44 (0)1242 227200 - Fax: +44 (0)1242 253200
Email: sales@cctglobal.com - Internet: http://www.cctglobal.com/



Customizing Excel 61

Excel 2000 Advanced [0 1995-2000 - Cheltenham Computer Training

Custom Lists Options

Man, Tue, Wed, Thu, Fri,
Monday, Tuesday, Wedn
Jan, Feb, Mar, Apr, May,
January, February, Marcl

Chart

USED FOR
TRAINING
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Color

SAMPLE ONLY
NOT TO BE
USED FOR
TRAINING

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Customize fol=y) —
Toolpars | Commands | Options I |T St
v Formating Right click
v e HEw, . Chart
F 3-[:j Settings Rename... Clipboard on any
Audit
r Chat o Control Toolbox too I bar
r Chart Menu Bar Drawi
T oo | Fromthe
F Control Toolbox Attach EAg=]| D)
D f. -
e Forms Pop-up
| .
E;:::a Data Picture menu ,
™ Full Screen PivotTable
I Picture Jhd| SeleCt
Reviewing .
=) visual Biasic Customize
=]
wardirk
+
Use Alt+Drag to .
remove Icons
Cuskomize, ..

Excel 2000 Advanced - Slide No. 3/

Customizing Toolbars

To move a
toolbar

To customizera
toolbar

Toreset a
toolbar which
you have
customized

Click on the toolbar you wish to move. Make sure you click on the toolbar
background, not the buttons.
Drag the toolbar to a new location.

Display the toolbar you wish to-customize.

From the View menu, select Toolbars and then Customize to display the
Customize dialog box.

Click on the Commands tab to display the Commands folder.

To add-a button'to the toolbar, select the category you require from the

Categories list box. Click on the button you want-and drag.it to the toolbar.

To delete a button, drag it off the toolbar.
Select Close when you have finished.

From:the-View menu; select Toolbars—~and then.Customize to display the
Customize_dialog box.

Click on the Toolbars tab to display the Toolbars folder.

In"the Toolbars "list box, highlight the name of the toolbar.

Click the Reset button to return the toolbar to its original format.
Select-Close-when you have finished:

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Review Questions

Review Questions - How Would You ...

Use the View Options?

Use the Calculation Options?

Use the Edit Options?

Use the Transition Options?

Use the General Options?

Use the Custom Lists Options?

Use the Chart Options?

Use the Color Options?

Customize a‘toolbar?

Bl|O(®|N[o|g|h wINIE

Reset a toolbar which you have customized?

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Security and Proofing within Excel

Learning Module Objectives

When you have completed this » Use the spell checker
learning module you w ill h ave » Share a workbook
seen how to: » Set data validation for a range of cells

e Set Input messages

e Set Error Alerts

» Specify a password for opening or saving a workbook
* Use passwords

» Create backups

» Hide worksheet elements

» Protect cells

* Use Auditing Tools

* Manipulate comments

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Auditing and Security Features
within Excel 2000

. Spell Checker /\\\
]
* Cell Notes i
|
8l
* Password Ei
&
* Tracing H
e Information Window BRESS |
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Auditing and Security Features within Excel 2000

Background If worksheets are developed for other users, it is important that the users find them easy
to use, and hard to "break”. Protection should be built-in to the worksheets to prevent
unauthorized tampering with the sheet, but allow data entry, as required, to specific
parts of the sheet.

It'is also very important that a worksheet is properly audited for errors, prior to release
on other unsuspecting users.

When developing worksheets.for.others-bare in mind.the following:

* Protect items such as formulas and data that must not be changed.

» Protect or hide any sensitive information contained within the worksheet.

" You maywant worksheets to be shared across‘anetwork:

* You should document any calculation or concepts contained within a workbook.

Levels of security offered by Excel:

» | Top level security is offered by use of a' password that restricts unauthorized users
from opening a'workbook:file.

* Workbook protection.

* Worksheet protection.

» Object protection (cells or charts).

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Spelling Checker

ey
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The Spell Checker

To use the spell *  Select a single cell to check the entire worksheet.
checker »  From the Tools menu, select Spelling .
« If noincorrect words are found, the Spelling dialog box will not appear. A box
will appear to tell'you that Excel has finished checking the spelling.
» If the Spelling..dialog box is displayed, select one of the following options:

Add Will add the word to the current custom dictionary.
Cancel Will stop the spelling check.
Change Will"'change this occurrence of the word to the word displayed in the

Change to text box.

Change All._| Will change all occurrences of the word to the word displayed in the
Change to text box.

Ignore Will ignore the word and continue.
Ignore All Will ignore all further occurrences of the word:in the document.
Suggest Will suggest alternative words from the dictionary.

* Ifyou began the spelling check in the middle of the worksheet, you may be
asked whether you want to continue checking at the beginning of the sheet.
Select Yes.

*  When the spelling check is complete, a box will appear. Select OK.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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What Are Shared Workbooks?

* A workbook can be made available over a
network and many people can work on the shared
workbook at the same time

* Each user can modify the workbook (including
the data, rows, columns etc)

* Each user can apply filters to the data and not
affect other users sharing the workbook

\\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 3/

What Are Shared Workbooks?

To allow « From the Tools drop down Share Workbook
workbook menu, select the Share {Edtina | advanced |
sharing Workbook command, which will T llos changas by more then one user ot the sams tin.
display the Share Workbook {1 s slons vrtbosk g
dialog box. o hs this

« / Click on the Allow changes by
more than one user at the
same time check box.

* Click on the-OK button-and the
system will force you to save

your.workbook at this point. =
* Whenyou re-open the Share e ser |

Workbook dialog box, you will

notice that the Workbook is.no |

longer marked as exclusive.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Between Users

View

\\ © Cheltenham Computer Training 1995-2000

Advanced Workbook Sharing Options

Share Workbook EHE
« Track Changes Edting |
Track changes
® U pdate Chang es & Keep change history For: ISD 5‘ days

* Conflicting Changes

* |Include in Personal

\

" Don't keep change history

Update changes
& wWhen File is saved
€ Automatically every: |15 5‘ minukes
% Save my changes and see others' changes
£ Just see other users' changes
Conflicting changes between users
& sk me which changes win

~ The changes being saved win

Include in personal view
v Brink settings v Filter sektings

Ok I Canicel |
Excel 2000 Advanced - Slide No. 40

Advanced Workbook Sharing Options

To customize * Click on the Tools drop down menu and select the Share Workbook
the Advanced command. The Share Workbook dialog box will be displayed.
Workbook « Set the options as required.

Sharing Optiens

Track changes

Allows you to-keep a log of changes which by default will
be kept for 30 days.

Update changes

Allows you to see your changes and changes made by
others each time you save.

personal view

Conflicting The default Ask me which changes win~ will cause the
changes Resolve Conflict  dialog to be displayed from which you
between users can decide how to handle conflicting data.

Include in Allows you to specify your own print and filter details

which will always be available to you when you use the
workbook.

SAMPLE ONLY NOT TO BE USED FOR TRAINING

O Cheltenham Computer Training 1995-2000 - Tel: +44 (0)1242 227200 - Fax: +44 (0)1242 253200
Email: sales@cctglobal.com - Internet: http://www.cctglobal.com/



70

Security and Proofing within Excel

[0 1995-2000 - Cheltenham Computer Training

Excel 2000 Advanced

/

* Allows you to
specify the type
of data that is
entered into a
range of cells

Allow:

Data:

Minirnurn:

Data Validation

Data Validation

Settings | Input Message | Error Alert I

Yalidation criteria
TS - |
Ibetween - l

\

HE

¥ Ignore blank

Maximum:

Y

™ &pply these changes ko all other cells with the same settings

3

[ ]

Caneel

Clear all |
© Cheltenham Computer Training 1995-2000
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Data Validation

To set data .
validation for a .
range of cells

Select a range within the worksheet that you wish to set data validation for.
Click on the Data drop down menu and then select the Validation command,
which will display the Data Validation dialog box.

* /' Click on the Allow drop down list, and select the type of data that you wish to
allow to be entered into the selected range.

« In this case we have selected Whole number.. Also we have decided to only
allow whole numbers between 0 and 99.

D ata Yalidation

Sektings | Input Message I Error Alert I

Walidation criteria

Allow:
Iwhole number
Duaka:

Ibetween

[
[

Minirnum:

v Ignore blank

i

Maximurn:

3

EE]

I~ apply these changes ko all other cells with the same settings

3

Clear all |

[ o ]

Cancel
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To set Input * From the Data Validation dialog box, select the Input Message tab.
messages * Inthe Title text box enter the title for the message.

* Inthe Input message text box, enter the text of your message.

Data ¥alidation EHE

Settings  Input Message | Errar Alerk I

W Show input message when cell is selected
When cell is selected, show this input message:
Title:
ICheItenham Computer Training

Input message:
The walue must Fall between 0 and 99 ;l

I |

Clear Al | [0]4 I Cancel |

To display Input « Once you have set an input message and closed the Data Validation dialog
messages box, simply clicking on a cell that has been formatted with an input message will
display the message, as illustrated below.

Cheltenham Computer Training
The walue must fall bebween 0 and 29

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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To set Error * From the Data Validation dialog box, select the Error Alert tab.
Alerts » Use the Style drop down to select the style or error alert, Stop, Warning or
Information .
* Inthe Title text box enter the title for the message.
* Inthe Error message text box, enter the text of your message.
Data Yalidation FHE
Setkings I Input Message  Error 8lert |
v Show error alert after irvalid data is entered
when user enters invalid data, show this errar alerk:
Skyle: Title:
IStDD j |Cheltenham Cornputer Training
Errar message:
Q The walue you have entered is outside the ;I
range 0-99,
Clear all | QK I Cancel |
To display an « Once you have set an input message and closed the Data Validation dialog
error alert box, when you try to enter the wrong type of data into a data validated cell it will

cause the error alert to be displayed when you press the Enter key, as
illustrated below.

Cheltenham Computer Training

Q The walue vou have entered is outside the range 0-99,

Cancel |

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Workbook Password Protection
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Workbook Password Protection

To specify a *  From the File drop down menu select IO
password for Save As.

opening a «  From the Save As dialog box, clickon T Always create backup

workbook the Tools icon, File sharing

Password to open: I
| Toals ~ Password bo modify: I

and from the drop down list displayed I Read-onky recommended
select General Options , which will
(04 I Cancel I

display the Save Options dialog box,
as illustrated right.

«  Enter a password into the Password to open text box. In future you will be
required to enter this password in order to open the file.

*  Click on the OK button. You will be asked to re-type the password to ensure that it
is consistent.

» The password can-be up-to 15 characters in.length and is case sensitive.

* You will also be prompted for this password if a formula is entered in a different
workbook, that refers to a cell(s) in the protected workbook.

WARNING!
If you forget the password there is no'way to retrieve the information contained within
the workbook.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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To specify a
password for
saving a
workbook

To use the
“Read-only
recommended
option

To use the
“Always create
backup” option

To remove a
password from
an Excel
workbook

Excel 2000 Advanced

From the File drop down menu select Save As.

From the Save As dialog box, click on the Tools icon, | Tools =
and from the drop down list displayed select General Options , which will display
the Save Options dialog box.

Enter a password into the Password to modify text box. In future you will be
required to enter this password in order to save the file.

is consistent.
The password can be up to 15 characters in length and is case sensitive.

This gives others the ability to open, view and edit a workbook, but not to save it with
the same name. They must use the Save As command under the File drop down
menu to save a modified version of the workbook with a different name.

WARNING: It is possible for another user to open a workbook file that is "Write

Reservation Password” protected. They can save it to another name, and then use the

underlying operating system (i.e. DOS) to rename the new version of the file with the
original version of the protected file.

If this check box is checked,
the following dialog box is
displayed when the file is re-
opened.

'Bookl.xls' should be opened as read-only unless you need to save changes Lo it,
Open as read-only?

)

Cancel |

Click on the OK button. You will be asked to re-type the password to ensure that it

Microsoft Excel E

This option is useful as it deters people from “messing about” with workbooks that

should not be altered, but at the same time allows people the chance to make changes

if really required.

This check box forces Excel to create a backup copy of the file every time a worksheet
file is saved. /The fileextension/BAK"is used;and the backup file is.saved in the same

folder as the original file.

You can open'the backup file'if the original file'becomes corrupted, or'if you have made

a series of mistakes in the original (which you did not notice until you re-saved the
original).

WARNING! All Excel automatic backup files are stored with the file extension BAK. If

you had two-files in the same folder, one-called CCT.XLS and-the other called
CCT.XLT, then the backup files would overwrite each other!

. Microsoft Excel

3

Open the workbook containing the
password you wish'to remove (by
entering.the password when
prompted). From the File drop down
menu select the Save As command,
and then click.on the Tools icon and

The file 'C:4ky Documentshfredtest. <ls' already exists.
Feplace existing file?

then select the General Options
command.

Clear either or both passwords (asterisks will display that there is a password).
Click on the OK button to close the Save Options dialog box.

Click on the Save button to save the file, which will display the dialog box above.
Click on the Yes button. The password has now been removed from the file

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Workbook Protection

Protect Workbook B E |

Protect workbook For
v Skruckure
[ windows

Password (optional):

Ik I Cancel |

\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. AJ

Workbook Protection

To protect a e Select the Protection command from the Tools drop down menu, then select
workbook Protect Workbook .
*  This will display the Protect Workbook dialog box as shown above.

Password Optional-password of up to 255 characters; which is case
sensitive.
Structure Prevents any changes to the structure of the workbook if

checked. l.e. you will be unable to edit, insert, delete,
rename, copy;:move or-hide sheets:

Windows Prevents changes to the workbooks size. The windows re-
sizing controls (close, maximize, minimize and restore) are
hidden.

WARNING

Protecting a workbook will mean:

* | You will be unable to add a new chart sheet using the ChartWizard

* You will'berunableto'display source data for-a‘cell in a pivot table

* You will be unable to record a macro onto a new sheet

* You.will be.unable to use.the scenario manager to create a new scenario

To un-protect a » Select the Protection. command from the Tools drop‘down menu.
workbook » Select the Unprotect Workbook ‘command and if prompted, enter the required
password.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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* Worksheet protection of

\

Worksheet Protection

— Cells and Charts Protect 5heet HE |
— Graphic Objects Prokect worksheet For

¥ Corntents
— Scenarios ¥ ohjects

¥ Scenarios

Password (optional):

(4 I Cancel I

Worksheet Protection

Background

To protect a
worksheet

To un-protect a
worksheet

Used to prevent users from altering the contents of a worksheet.

» Select the Protection command from the Tools drop down menu.
/" Select Protect Sheet |, which displays the Protect Sheet dialogbox, as illustrated

above.
Password The password is optional and can be up to 255 characters. It is case
sensitive.
Contents Protects'worksheet cells-and charts:
Qbjects Protects graphic objects on worksheets (including embedded charts).
Scenarios Protects scenarios and prevents changes to scenario definitions.

» Select the Protection command from the Tools drop down menu.
» 1 Select Unprotect-Sheet; .
» | If prompted, enter the required password.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Hiding sheets,
rows or columns

To hide an entire
sheet

To hide a row

To hide a
column

[0 1995-2000 - Cheltenham Computer Training

TIP: Instead of protecting a worksheet, you can hide an entire sheet, a row, or a
column.

» Select Sheet from the Format drop down menu.
* Select Hide.

» Select the row you wish to hide.
» Select the Row command from the Format drop down menu.
* Select Hide.

» Select the column you wish to hide.

» Select the Column command from the Format drop down menu.
* Select Hide.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Cell Protection

Format Cells E

Murnber I Aligrment I Fank I Border I Patterns i

W Locked
™ Hidden

Locking cells or hiding Formulas has no effect unless the
worksheet is protected. To protect the worksheet, choose
Prokection fram the Toaols menu, and then choose Protect
Sheet, & password is optional.

K I Cancel
© Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 45

Cell Protection

To protect a cell » Select the Cells command from the Format drop down menu, which displays the
Format Cells dialog box, and select the Protection tab as illustrated above.

Locked Prevents any'modification to cells once the sheet is protected.
Hidden Hides formulae, after the sheet is protected.
NOTE:
1.. Cell protection.will-not take-effect until.the worksheet is-protected (with Contents
checked).

2. By default all cells are locked. You must unlock any cell that you wish users to be
able to edit BEFORE YOU LOCK THE WORKSHEET!

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Excel 2000 Auditing Tools

* The audit feature allows you to detect problems
which may occur in your worksheet formulas

The toolbar can be displayed by selecting
Toolbars from the View menu to display the
Toolbars menu and then selecting Customize

Click on the Toolbars tab and select the check
box next to Auditing in the Toolbars list box and
then select Close

T o | o 2

\

F
ey

® 12| E &

\\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 4/

Excel 2000 Auditing Tools

New Comment Will display the Cell Note dialog box to enable you to attach text or
ﬁ audio comments.
Remove All P Will delete all arrows from @an active worksheet.
Arrows K
Remove o Will delete dependent tracer arrows from an active worksheet.
Dependent Arrows =
Remove o Will delete the precedent.tracer arrows from-an-active worksheet.
Precedent Arrows a
Trace Dependants o Arrows are drawn from the active cells to cells containing formulas
T which use the values in the active cell (dependants)
5 .
Trace Error Will draw an arrow from cells which may have caused an error to an
@ error value in an active cell.
Trace Precedents o Arrows are drawn from all cells which supply values directly to the
g formula in the active cell (precedents).

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Auditing Worksheets

* You can use tracers to find precedents,
dependents, and errors in any cell in a worksheet

* Precedents
— Cells which are referred to by a formula

* Dependents
— Cells which contain formulas which refer to other cells

* You must ensure that the Hide All option button
is not selected before using tracers

\\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. AJ

Auditing Worksheets

To use tracers to
audit a worksheet

To trace the
precedents of a
cell

To trace the
dependants of a
cell

You can use tracers to find precedents, dependants and errors in any cell in a
worksheet.

Precedents -"Cells which are referred to:by a formula.
Dependants__-- Cells which-contain formulas which refer to other cells.

You must ensure that the Hide All option button is not selected before using
tracers. From the Tools menu, choose Options and click on the View tab.
The Hide All-option button-in the-Objects area.should-be white (not
selected).

Choose OK to exit.

Highlight a cell which contains the formula you wish to trace.

From the Tools menu, choose Auditing Trace Precedents or click on the
Trace Precedents. icon.on the Auditing toolbar. Tracer arrows will be
displayed. Solid or blue arrows indicate direct precedents of a selected
formula; dotted or red arrows indicate a formula which refers to error values;
dashed-arrows with a-spreadsheet icon referto external worksheets.

Whilst working with tracers you can click on the Remove All Arrows icon to
remove all the tracers, or click the Remove Precedent Arrows icon on the
Auditing toolbar to remove one level of precedents at a time.

Highlight the cell (which should be referenced in.a formula) you wish to trace.
From the Tools menu, select Auditing Trace Dependants or click on the
Trace Dependants button on the Auditing toolbar. Tracer arrows will be
displayed, with blue or solid arrows indicating dependants of the selected
formula.

Whilst working with tracers you can click on the Remove All Arrows button to
remove all the tracers, or click the Remove Dependent Arrows button on the
Auditing toolbar to remove one level of dependants at a time.

SAMPLE ONLY NOT TO BE USED FOR TRAINING

O Cheltenham Computer Training 1995-2000 - Tel: +44 (0)1242 227200 - Fax: +44 (0)1242 253200

Email: sales@cctglobal.com - Internet: http://www.cctglobal.com/



Security and Proofing within Excel 81

Excel 2000 Advanced [0 1995-2000 - Cheltenham Computer Training

To trace errors in *  Highlight a cell which contains an error value: #DIV /0!, #N/A, #NAME?,
a cell #NULL!, #NUM!, #REF!, #VALUE!.
e From the Tools menu, choose Auditing Trace Error , or click on the Trace
Error button on the Auditing toolbar. Tracer arrows will be displayed,
pointing to the cells.

Dotted or red arrows - indicate that the first precedent formula contains an error.
Solid or blue arrows - indicate that precedents of the first formula are producing
an error.

*  Onthe Auditing toolbar, click the Remove All Arrows button, or select
Auditing Remove All Arrows  from the Tools menu.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Cell Notes and Documentation

* A useful means of documenting the spreadsheet

\\ © Cheltenham Computer Training 1995-2000 Excel 2000 Advanced - Slide No. 4/

Cell Comments

Background It is vitally important that complex worksheets are properly documented. This means
that you will still be able to understand what you have done a month from now, and
other people will easily understand any “clever bits” you have devised. One of the
changes made within:Excel 20007isthat cell'notes now “pop-up” when you hold the
mouse over cells that contain them.

To add a »  Select the cell to which you want to add the comment.

comment e From the Insert menu, choose Comment to display the Cell Note dialog box.
e Enter theitextin-the-Text-Note-box:
*  Click outside the box when finished.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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To display a *  Move your mouse
comment and hover over the Cheltenham

cell containing the B Computer Training:

comment - after a 2 |Thisis a note

short pause the 4

comment will be g

displayed.

*  There will be a small red marker in the top right-hand corner of the cell to indicate
that it contains a comment.

To edit a * Right click on the cell containing the comment you want to edit.
comment *  From the shortcut menu displayed, select the Edit Comment command.
» Edit the text in the Text Note box.
*  Click outside the box when finished.

To delete a * Right click on the cell containing the comment you want to delete.
comment *  From the shortcut menu displayed, select the Delete Comment command.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Excel 2000 Advanced
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Review Questions
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~

Review Questions - How Would You ...

Use the spell checker?

Share a workbook?

Set data validation for a range of cells?

Set Input messages?

Set Error Alerts?

Specify a password for opening or saving a workbook?

Use passwords?

Create backups?

O|P NPT A W

Hide worksheet elements?

l_\
o

Protect cells?

BN
[EEY

Use Auditing Tools?

l_\
N

Manipulate comments?

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Data Maps

Learning Module Objectives

When you have completed this * Place data onto a map
learning module you w ill h ave * Format a Data Map
seen how to:

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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What Are Data Maps?
Microzoft Excel =] E3
Help Topics|  Eack Optians
About displaying data in a map :I
A | B I C I D E [ S
1
2 [l Create a map from columns of data |
3 ™ =4
4 Hew SALES HIGH reached in SWEDEH!
L3 |
L6 | 5
7| N
5 aravay
q Finlar @%
[l Add Tabels and text to the map | e United Kingagrd P oy
11
112 | ; Denmar 4
13 - Total Sales
14 Plether M $22,300 to $25,600 (1)
e o E $158,5800 to $22,300 (3) [
= 2 $15,300 to $18,500 (3)
16 F Add formats and data to the map | [ 11,500 to $15,300 (31 5
17 | France = R g
I~

A\
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What Are Data Maps?

Background

To create a data
map

Excel 2000 has the ability to produce data maps to display your data as shaded
areas on maps. A workbook called Mapstats.xls containing demographic
data for each map available should be located in the following folder on your
system:

C:\Program Files\Common Files\Microsoft
Shared\Datamap\Data

[ Enter the data you require'to be'mapped into columns on‘your worksheet.

» The first column must contain geographical data-about the-map - area names,
abbreviations or post codes (formatted as text).
Area name information is defined in the Mapstats.xls workbook.

» Select the information to be mapped (as when creating charts).

» [ Click on.the'Insert-drop down menu and select'the Object. command. The
Object dialog box will be displayed.

» | Select Microsoft Map from the Object type " list.

» Click on the OK button to close the Object dialog box and

» At this point you may be asked to select the type of map you require, in which
case-select-the map from:the list andclick on OK.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Europe Countries |

\

The Data Map
Data Control Dialog Box

oft bl ap Control

|Ccu_|nt of Colurnn & |Cu:-|l_|mn E

To change data in the map, drag colunn and format buttans into the bax,

b=

L1 e
d |
I
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The Data Map Control Dialog Box

If the data map control dialog box is not visible when you have
selected the map click the Show/Hide Microsoft Map Control icon E

on the Data Map toolbar.

Value Shading

Different shades of the.same color are used to represent numeric data
values. Generally the darker the shade the greater the value.

Category - Various colors are used to show how regions belong to differing

Shading categories of information.

Dot Density Numeric data values are represented by dots (e.g. 1 dot per thousand).
The greater the number of dots'the higher-the value.

Graduated * Numeric data values are represented by a symbol, the larger the symbol

Symbols the greater the value.

Pie Chart In this format small pie charts are placed on each area to show the data

for each area.

Column Chart

Similar to the pie chart this format uses small column (bar) charts to
display data in each area.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Placing Data on a Map

Burope Countries
ty Calumn B

B 7uav i)

Oawav )
O:awad 1)
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Placing Data on a Map

To place data *  The Data Map Control dialog box may look like the one shown below with no
onto a map data in the working area. The map displayed for this has no data mapped onto
it.

[rata Map Control

UK Standard Regions |

Count of GEORAME
POP_392

To change data in the map, drag column and format buttons inta the box.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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» Using the mouse, drag the required data onto the work area and place it over
the dotted Column box, and release.

» The Value Shading format option is automatically applied to the dotted
Format box within the work area (as shown below).

* Note that the map now shows shadings for the data that has been mapped
onto it.

Data Map Contral

UK Standard Regions I

Count of GEORNAME

To change data in'Wge ghap, drag column and format buttons inta the bos.
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Formatting a Data Map

* Use the Microsoft Map toolbar that is displayed
automatically when you create or edit a Data Map

Excel 2000 Advanced

Excel 2000 Advanced - Slide No. 5/

Formatting a Data Map

To reposition
items on the
map

Click on the Select Objects icon.
Drag the required objects to a hew position.

To reposition‘a
map within its
frame

Click the Grabber icon.
Drag the map around the frame to the position where you want
it and release the mouse button.

To center the
map

Click the Center Map icon.

To add labels to
a map

Click the Map Labels icon.

Select the features to label.

Move the cursor over the map. When thelabeliis visible in the
position you. want-it; click to place the label.

To add text to a
map

Click the Add Text icon.
Place the cursor where the text is required and click once.
Type the text and complete with Enter .

To create a
custom pin

Click the Custom Pin Map icon.

To view whole
map

Click the Display Entire icon.

To redraw a
data map

Click the Redraw Map icon.

B |&sE 7B E |

SAMPLE ONLY NOT TO BE USED FOR TRAINING

O Cheltenham Computer Training 1995-2000 - Tel: +44 (0)1242 227200 - Fax: +44 (0)1242 253200

Email: sales@cctglobal.com - Internet: http://www.cctglobal.com/




Data Maps 91

Excel 2000 Advanced [0 1995-2000 - Cheltenham Computer Training

4 N

Review Questions
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Review Questions - How Would You ...

=

Place data onto a map?

2. Format a Data Map?

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Consolidation

Learning Module Objectives

When you have completed this » Consolidate data over several worksheets or worksheet
learning module you w ill h ave pages
seen how to: » Consolidate selected rows and columns from several

worksheets or pages

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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* This feature allows you to select blocks of data
from several different worksheets, or different
pages of the same workbook, and combine their
values into a single, summary range in a
workbook

This saves time, and is easier than cutting data
from several worksheets and pasting into one,
single worksheet

\

What is Consolidation?
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What is Consolidation?

To consolidate

data over
several

worksheets or
worksheet

pages

Highlight a cell on a blank worksheet page, or a blank area of a worksheet.
Select Consolidate from the Data menu to display the Consolidate dialog box.
Select the first area you wish to consolidate by clicking on the worksheet and
dragging to highlight the area required. Do not include row and column text,
only numeric data. Use the sheet tabs to change between worksheets.

The selection will appear in the Reference text box.

Note: Any formulas in the source area will only be used as values, i.e. only values

in the cells*will be used in‘the consolidation.

Click on the Add button when you have highlighted the required range.
Continue highlighting and adding the remaining areas in the consolidation.
From the Function drop-down list, select the function you require. The default
is Sum which will.add the.data across-the selected range.

If you want the summary report to create linking formulas to the source data
automatically, select the Create links to source data check box.

Select OKto complete the consolidation.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Consolidating Rows and Columns

Select Data Consolidate from the menu

\

Conzolidate HE

Function:
ISum j

Reference:

|| :“J Browse. .. |

All references:
[— add |
:I Delete |

rUse labels in
I Top row
I Left calumn [~ Create links to source data

(04 I Close
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Consolidating Rows and Columns

To consolidate
selected rows
and columns
from several
worksheets or

pages

Insert the row or column text you want to consolidate from the source ranges in
a blank worksheet page, or on a blank area of the worksheet. Ensure that you
type the text exactly as it appears in the source data ranges.

Highlight'the row or column labels you entered.

Select Consolidate from the-Data menu to display.the Consolidate dialog
box.

Select the first area you wish to consolidate by clicking on the worksheet and
dragging to highlight the area required. Make sure you include row and
column-text in'the'source-areas, as'well as numeric data:~Use the sheet tabs
to change between worksheets.

The selection will appear in the Reference text box. Note: Any formulas in
the source area will only be used as values, i.e. only values in the cells will be
used in the consolidation.

Click on.the Add. button.when you have highlighted.the required range.
Continue highlighting and adding the remaining areas in the consolidation.
From the Function drop down list, select the function you require. The default
is'Sum which will'add the'data across the selected range.

If you want the summary report to create linking formulas to the source data
automatically, select the Create links to source data _ check box.

If row text was entered at the first step, select the Top row check box in the
Use labels'in area...If column text was entered, select the Left column check
box.

To complete the consolidation, select OK.

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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Review Questions - How Would You ...

=

Consolidate data over several worksheets or worksheet pages?

2. Consolidate selected rows and columns from several worksheets or pages?

SAMPLE ONLY NOT TO BE USED FOR TRAINING
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